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Overview

This manual for the Generic Measurement System (GMS) contains information regarding the
installation and operation of the software.

The GMS automates testing procedures for optical devices. It can be used to test Insertion
Loss (IL), Back Reflection (BR), Power (PWR) and Polarization Dependent Loss (PDL).

Supported instruments:

• BR5 Backreflection Meter

• MBR5 Multi-Output Backreflection Meter

• MLT Multi-Output Loss Test Set

• SX4 & SX8 Optical Switches

• PDL5 BR/IL/PDL Meter

• EOTS Environmental Optical Test System

Features:

• Insertion loss, return loss and power testing through optical connectors

• Save results into Excel files with various saving options

• Simple and efficient, requires minimal operator training

• Easy saving, loading, and editing of test profiles

• Includes long-term testing options

• Real-time graphing capabilities

System Requirements:

• Windows 7 or higher

• Microsoft Excel (2007 or greater)

• .NET Framework 4.5

• National Instruments Drivers (for GPIB)
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Quick Start Guide

This chapter contains a concise guide of how to quickly set up the GMS and run a test for
a single instrument. For a more detailed guide of the software’s features refer to the corre-
sponding sections later in the manual.

Main Window

Figure 2.1: The main window of the GMS.
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1 File Menu Contains save/load profiles
2 Settings Menu Contains forms for software settings
3 Help Menu Contains information found in the manual
4 Start Button Initiates the test
5 Pause Button Pauses the test
6 Stop Button Stops the test
7 Alarms Configuration Contains options for setting warnings/failures
8 View Graph Plot the data collected during testing
9 Format Labels Button Choose row headers
10 Labels Header information (ex. Part Number, Serial Number, etc.)
11 Test Parameters Choose wavelengths, channels, test types, and detectors to

test
12 Insert Button Inserts the specified test (from test parameters) to the list
13 Test Profiles List A list of profiles the user can load easily. In order to load a

profile, select a profile from the list and double click on it.
14 Add/Remove Buttons Add/remove profiles to/from the list
15 Sequence View Test information is stored in this grid in a list format. The

grid lists the test sequence to be conducted in order from
top to bottom

16 Sequence/Results Tabs Switch between the test sequence window and the results
window

17 Save Button Saves test results presented on the main window
18 Acquisition Value Switch between taking a reference value or a measurement
19 Test Log Receive feedback on tests

The table above corresponds to Fig. 2.1 and serves as a guide to the Main Screen of the GMS
software.
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Configuring Instruments
• The first step is to access the Instrument Settings window (Fig. 2.2), which can be done
through the Settings Menu or by pressing Ctrl+I.

• Set the # of instruments to 1 for the purposes of this guide, and select the type of
instrument you are testing from the Instrument drop-down menu.

• Select from the Port drop-down menu either Serial or GPIB depending on how the in-
strument will be connected to GMS.

• Use the Auto Select button (or enter in the serial/GPIB values manually) to establish a
connection.

• Press the Test Port button to verify that a connection was established, and select yes
when asked to detect values automatically (this can also be changed manually).

• If the instrument fails to communicate through the port, make sure the right COM port
is selected. If it continues to fail, turn the instrument off and on then restart the software
and try again.

Figure 2.2: The Instrument Settings window for a BR5 connected via GPIB.
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Configuring Test Parameters
• The first step is to access the Test Settings window (Fig. 2.3), which can be done through
the Settings Menu or by pressing Ctrl+T.

• There are three tabs in this window, Test Format, Test Length and Save Options.

• Under Test Format select the device type, a meter or a switch. If only one device is
connected this will be defaulted to the proper device type.

• The test parameter order can be chosen using the drop-down lists labelled ’First:’, ’Sec-
ond:’, etc. The available parameters vary depending on the instrument being tested.

• Under Test Length at the top of the window check the box marked ’Enable Long Term
Testing’ if you wish to run repeated tests on a DUT.

– If long term testing is enabled, choose between an iteration test or a duration test
and input the desired # of iterations or the duration. See Test Length for more
details.

• Under Save Options are two tabs labeled Long Term Test and Single Test (Fig. 2.4). For
the purposes of this guide select Single Test.

• Select ”Save each test result to separate file” under Single Test.

Figure 2.3: The Test Format and Test Length tabs for a meter type device.
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Figure 2.4: The Save Options tab for single tests.

Running a Sequence
• Select the Sequence tab on the main screen so that the desired test conditions can be
entered (Fig. 2.5 and Fig. 2.6).

• First select the registered instrument from the Instrument list.

• Select the desired test parameters such as wavelength, channel and test type from the
lists below. The three available test types are insertion loss (IL), backreflection (BR) and
power (PWR).

• When all the parameters are selected press the Insert button to add a test to the Test
List below.

Figure 2.5: An example of a BR5 insertion loss (IL) test at 1490nm.
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• Add as many tests as necessary using the previous method, and delete any unwanted
tests by left-clicking on the row number and pressing the Delete key.

• A reference value must be taken before any measurements. Ensure that Reference is
selected under Acquisition (Fig. 2.1 - 18) and press the Start button. Press Retry in the
dialogue box if not satisfied with the value, otherwise press OK.

• For more information on referencing, see Taking a Reference.

• Press the Start button again to run the prepared tests.

• View the tabulated results in the Results tab or press the Save Results button to save
results as an Excel file if not specified earlier.

Figure 2.6: Three sample tests run on a BR5 (for BR, PWR and IL) at three different
wavelengths (1625, 1310 and 1490). Measurement readings are displayed in decibels (dB).
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Software Installation

To install the GMS software run ”JGR Optics GMS Setup 3.5.0”. Press the Next button on the
bottom of the window to proceed through the installation process.

Figure 3.1: Opening window of installation.

• Ensure that all prerequisites are installed on the system (Fig. 3.1).

• Step through the wizard to complete the installation. If the installation was successful
you will see the window in Fig. 3.2.
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Figure 3.2: Finish the installation and open the GMS.
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Software Configuration

Before running any test using the GMS, the software must be configured properly. This in-
cludes establishing a connection with the instruments to be used, as well as configuring the
test parameters, test length and test save options.

Configuring Instruments
Connecting Instruments

• To set up instruments, first enter the Instrument Settings window through the Settings
Menu or by pressing Ctrl+I (Fig. 4.1 and Fig. 4.2).

• Specify the number of instruments to be used. If more than one instrument is being
used the user can switch between instruments using the Instrument # drop-down list.

• Use the Instrument and Port drop-down lists to specify which type of instrument is going
to be tested and how it will connect to the GMS (either Serial port or GPIB).

• Fill in the appropriate connection port values manually or press the Auto Select button
to establish a connection. Use the Test Port button to verify that a connection was made
successfully.

• An optional prompt may appear asking to fill in the detected parameter fields. These
can also be filled in manually.

After all the instrument settings are configured, click OK to apply and save the settings. These
settings are saved in a configuration file and will be loaded each time the software is run.

Note: the instrument settings are saved as part of the software settings and are independent
of test profiles (these settings are static and do not change when a different profile is loaded).
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Meters vs Switches
The two classifications of devices compatible with the GMS are meters and switches. The
device parameter fields depend primarily on which of these two types is being used.

Configuring Meters (BR5, MBR5, MLT and PDL5):
• Address: Refers to the GPIB address of the instrument (if using GPIB port) or the COM
port of the instrument (if using serial port).

• Number of Channels: Refers to the number of output channels available on the meter.
Both the MBR5 and MLT have multiple output channels, whereas the BR5 and PDL5 have
only one.

• Number of Detectors: This setting only applies to the MLT and refers to the number of
detectors available on the instrument.

• Wavelengths: Type the available wavelength(s) in the boxes using integer numbers only.
Up to four (4) wavelengths can be defined.

Figure 4.1: The Instrument Settings for an MBR5 meter via GPIB.
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Configuring a Switch (SX4/SX8):
• Address: Refers to the GPIB address of the instrument (if using GPIB port) or the COM
port of the instrument (if using serial port).

• # of Modules: Enter the number of modules on the switch being used.

• Channel: First select a module number from the # of Modules drop down list and enter
the number of channels available for that module. Repeat the operation for all switch
modules.

Figure 4.2: The Instrument Settings for an SX8 switch via serial port.
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Configuring Test Settings
Now that the instrument(s) have been connected the desired test parameters can be regis-
tered. Begin by entering the Test Settings window either through the Settings Menu or by
pressing Ctrl+T. The Test Settings window has three tabs: Test Format, Test Length and Save
Options.

Test Format is used to order the testing parameters on the main screen. Test Length is used
to specify the number of iterations or the duration of a test. Save Options is used to specify
where and how the test results will be saved.

Test Format
Ordering Parameter Columns:

• Under Test Format choose the type of device being tested (meter or a switch) from the
drop-down list (see Fig. 4.3).

• The next step is to choose how the test parameters will be listed on the main screen test
list by ordering the parameter columns order.

• Use the list labeled First for the first column, Second for the second column, etc.

Figure 4.3: The test order for a meter device. An example of the column order is shown at the bottom.
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Different Instrument Options:
The drop down lists located on the left and marked from First to Fourth vary depending on
the type of instrument chosen.

• MBR5 - channel, wavelength, and test type.
• BR5 - wavelength, and test type.
• MLT - wavelength, channel, test type, detector.
• Switch - none.
• EOTS - channel, wavelength, and test type.

The same parameter cannot appear more than once. When a valid format is specified, an
example usiong the selected parameters is displayed on the right side of the window.

Test Length
Setting up an Iteration or Duration Test:

• Under the Test Length tab there is a check-box labeled Enable Long Term Testing (see
Fig. 4.4).

• If left unchecked any tests performed will run for a single iteration only.
• Enabling the option allows the user to setup either an iteration test or a duration test.
• Enter in numerical values for the test duration or use the arrows on the # of Iterations
text box to specify the desired test length.

Figure 4.4: The Test Length settings window with long term testing enabled.
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Setting Command Delays and Minimum Sequence Times:
• For both of these tests the Delay After Each Command options are made available, as
well as the Set Minimum Sequence Test Time options for the Duration Test option.

• Enable the Delay After Each Command and Set Minimum Sequence Test Time options
using the check-boxes and enter the desired values into the text boxes.

• The Delay After Each Command option specifies the amount of time the software will
wait after executing one command before moving on to the next.

• The Minimum Sequence Test Time can be used to delay the start of multiple sequences.
If a sequence with a minimum test time of 45 minutes finishes after 30 minutes, the
software will wait 15 minutes before beginning the next sequence.

Save Options
The Save Options tab has two windows, one for a Long Term Test and one for a Single Test
(Fig. 4.5 and Fig. 4.6). If the Enable Long Term Testing box was checked in the last step then
use the Long Term window, otherwise use the Single Test window.

The user can opt to have the resulting Excel file open upon test completion for either option
using the corresponding check-box. Both Long Term and Single Testing allow the use of
custom Excel templates. See Custom Excel Templates for more information.

Long Term Save Options:
• To save a long term test simply specify the desired save location and file name using the
browse option.

• Specify the saving frequency of the data file by entering a value in minutes.
• The option to append results to an existing file can be opted into using a check-box.

Figure 4.5: The Long Term save options window.
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Single Test Save Options:
• The single test option allows the user to either save all test results in a single file or save
individual results in separate files.

• When saving results in separate files the option to Auto Generate file names is available,
or they can be named later after the tests have been performed on the main screen.

Figure 4.6: The Single Test save options window.

• To make use of the Auto Generate function specify a Save Directory using the browse
function and use the File Name Format List by checking the values to be included in the
file names.

• When saving multiple tests to a single file simply use the browse function to specify a
save location and file name.
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Custom Excel Templates
For both save options, Custom Excel templates can be loaded associated with a test profile.
Changing the profile will change the template.

• To enable this features select the ”Use an existing excel template” check-box found in
the appropriate save window (Long Term Test or Single Test).

• To create a custom template the user must first start from a saved Excel results file
(Fig. 4.7).

• By default a results file with have two Worksheets, ’Sequence’ and ’Results’. To add a
Worksheet click the icon to the right of the Results Worksheet tab.

• In Fig. 4.7 a new tab called ’Label’ has been added. This is where the customization
should occur.

Figure 4.7: An example of a custom Excel template file. Press the new Worksheet button to begin
editing a custom Excel Template.

• On the new Worksheet custom formulas and labels can be added that incorporate data
from the Sequence and Results Worksheets (Fig. 4.8).

• To incorporate this Excel template into future tests use the Browse function under the
Excel template check-box to select the newly created Excel template (Fig. 4.9).

• The test will run as normal but will now save to an Excel file with the user’s custom
Worksheets and formulas.
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Figure 4.8: An example of a custom Excel template with an added Label Worksheet. The value in
cell H2 of the Sequence Worksheet has been added to cell D7 in the Label Worksheet.

Figure 4.9: Selecting a custom template for use in a test.
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Other Settings
Thermometer Settings
This latest version of GMS has the ability to continuously monitor temperature and humidity.
GMS is currently compatible with thermometers such as Omega’s iTHX-W3 Temperature and
Humidity Chart Recorder, useful when performing long term environmental tests.

• Communication with the thermometer is possible via Ethernet.
• As indicated in Fig. 4.10, only the IP Address and Port have to be provided.
• Enable the thermometer using the check-box, select the desired instrument from the
drop-down list and enter corresponding Ethernet settings.

• Verify that a connection was established using the Test Connection button.

Figure 4.10: The thermometer settings window.

User Interface Settings
Users can customize GMS by specifying keyboard shortcuts, locking interace controls and
selecting language and help options.

UI Shortcut Options:
• This menu (Fig. 4.11) can be accessed either through the Settings menu or by pressing
Ctrl+U.

• Under Keyboard Shortcuts type in the desired shortcut in the text-box next to the name
of the command in question. By default only the Start command is listed.

• Enable Footpedal Shortcuts creates two more command fields, Start (via Footpedal) and
Goto 1st Header. Each command can be one character long.

• The Start commands will initiate a test sequence, while the Goto 1st Header command
moves the cursor to the first header label text box.
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Locking and Disabling Modes:
• Under Interface Options there are three check-boxes: Disable Reference Mode, Disable
Headers and Lock Profiles List.

• Disable Reference Mode when clicked removes the Acquisition selection menu on the
main screen and defaults any data readings to Measurement and not Reference.

• Disable Headers removes the header and label fields on the main screen.

• Lock Profiles List removes the Add and Remove buttons from the Test Profile List on the
main screen, while still allowing the user to load profiles from the list.

• The user can lock all interface controls by accessing Lock Controls from the Settings
menu or by pressing Ctrl+L. This will disable all buttons on the main screen except Start,
View Graph and Save Results.

Figure 4.11: The User Interface Settings window.

• The Force Reference on Profile Load check-box will prompt the user to reference the
instruments associated with the profile’s test list automatically.

Language and Help Options
• The user can select the software language from the Settings menu under Language.
English, French and Chinese are available.

• Under the Help menu is a Help Contents option that leads to this manual.
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Setting Up a Test Profile

A test profile describes a sequence of tests to be performed on the instrument and contains
additional information required by the user. The test profile contains information regarding
the channel, module, wavelength, and detector settings for each test (as applicable to the
instrument).

The profile also stores information regarding test Alarms, Test Settings, User Interface Settings
and current language. Once the test profile has been configured, it can be used for immediate
testing or it can be saved for later use.

Creating a New Test Profile
Saving and Starting New Profiles

• When the program is started, a new test profile is automatically opened. To start a
new profile at any time, select “New Profile” from the “File” menu or use the keyboard
shortcut Ctrl+N.

• If any changes have been made to the currently opened test profile, you will be asked if
you wish to save the changes (see Fig. 5.1).

• Choosing to save the changes will bring up a “Save as” dialog (see Fig. 5.2) if the profile
has not been previously saved and named. Choosing to “Cancel” will abort the new
profile and will keep the existing profile open.

Figure 5.1: This window appears if changes to a previously open test profile were not saved.
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Figure 5.2: Save dialog for a test profile.

Instrument Type:
• Every Test Profile includes at least one test instrument but can include several different
instruments (BR5, MBR5, etc.).

• You can switch between the different registered instruments at any time by using the
drop-down menu above the Test List.

• You should ensure that the instrument settings are properly configured before beginning
any test sequences (see Configuring Instruments for more information on configuring
the instrument settings).
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Configuring Header Labels
Using Header Labels:

• The header labels allow you to specify additional information about the instrument or
about the test sequence.

• Examples of these fields include “Serial Number”, “Part Number”, “Connector Side”, and
“Test Number”.

• Each user-input field consists of a field name, saved as part of the test profile, and the
field’s contents, specified by you at some point prior to saving the test results.

• Both the field’s name and its contents are saved with the test results.

Editing Header Labels:
• The Header Labels can be modified by pressing the Format Labels button on the main
screen.

• The Description Table Format window (see Fig. 5.3) contains a text box for specifying the
number of Header Text Rows, up to a maximum of 9. Enter in the desired value.

• Below this the Row Headers will update to reflect the new number. They can be edited
directly by entering the desired header name.

• If the Row Header names are numerical the Auto Increment on Save option can be en-
abled, which will automatically increment the header by 1 after each save.

Figure 5.3: The label headers as they appear on the main screen (left) and the
Description Table Format window used to edit them (right).
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Alarms
Alarms allow you to be immediately notified when a measured value does not fall within
specifications. To configure the alarms, click on the Alarm button to bring up the alarm
configuration dialog (see Fig. 5.4).

Figure 5.4: The alarms window.

Setting Up and Managing Alarms
Creating and Editing Alarms:

• To add a new alarm to the alarm list, click the New Alarm button. The alarm will be added
to the list and selected for editing.

• Once an alarm has been added to the list, its parameters may be defined. You must
select a warning type, test type and alarm criteria from the three drop-down lists as well
as specify a threshold value using the parameter specification (see Fig. 5.5).

• If a test result triggers both a warning and a failure the failure will take priority when
highlighting the result.

• An alarm may be edited by clicking on the alarm in the alarm list. The selected alarm
will be highlighted and its parameters will appear in the parameter specification inputs.

Saving and Deleting Alarms:
• To delete an alarm from the alarm list, select the alarm by clicking on it in the list. The
alarm should now be highlighted. Once the alarm is selected, it may be deleted by
clicking the Remove Alarm button.

• To save changes to the alarm dialog the OK button must be pressed before exiting.

• Changes will not save if any alarm is not of the correct format, i.e. “<alarm #>. <alarm
type> if <test type> is <alarm criteria> <threshold value> <“dB” or “dBm”>”.
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Figure 5.5: Creating a warning to trigger if the power is greater than -45dB.

Further Alarm Customization
• Warnings and failures can be assigned colours so that when they are triggered they are
immediately recognizable in the Sequence View.

• This can be set by clicking on the colour squares next to the Warning and Fail labels and
choosing from the colour menu window (see Fig. 5.6).

• Failures can be further identified by enabling the Beep on Failure check-box in the bot-
tom left corner of the window.

Figure 5.6: The warnings are set to appear as green and the failures as red. The
bottom half of the figures shows how they would appear in the Sequence View.
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Saving and Loading Test Profiles
Saving a Test Profile

• A new test profile may be saved by selecting “Save Profile as…” from the “File” menu or
using the keyboard shortcut Ctrl+S.

• This will open a “Save as” dialog where the profile name and save location may be spec-
ified.

• When saving changes to a named profile (previously saved) you may also choose the
“Save” option from the “File” menu.

• For named test profiles, the keyboard shortcut for the “Save” option is Ctrl+S. The option
“Save Profile as…” is still available to let you save the test profile under a new name but
the keyboard shortcut is changed to Ctrl+Shift+S.

Loading a Test Profile
• To load an existing profile, select “Load Profile” from the “File” menu or use the keyboard
shortcut Ctrl+O.

• If any changes have been made to the currently opened test profile or there is no cur-
rently loaded profile, a dialog will appear asking if you wish to save the profile changes.

• Choosing to save the changes will bring up a “Save as” dialog if the profile has not been
previously saved and named. Choosing to “Cancel” will abort the load profile process
and will keep the existing profile open.

• This dialog will only appear if you have made changes to the current test profile. If not,
the Open File dialog will appear. Find the desired profile and click ’Open’.

The Test Profile List
The test profile list provides you with a method by which to quickly load commonly used test
profiles (see Fig. 5.7).

• When the program is started, the test profile list is loaded. Each profile is checked to
ensure it still exists.

• If a profile does not exist or its system location has changed, the profile is automatically
removed from the test profile list.

• To add a profile to the list, click the “Add” button in the Main Window.

• An open file dialog will be presented. Use the dialog to navigate to the location of
the desired profile and select the profile. Select “Open” to add the profile to the list or
“Cancel” to cancel the process.

• To remove a profile from the test profile list, select the profile to be deleted by clicking
on it in the list and clicking the “Remove” button.

• To load a profile from the test profile list, double-click on the profile.

• As with loading a test profile via the “Load Profile” option, if any changes have been
made to the current profile, you will be asked if he/she wishes to save the changes.
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Note that changes to the test profile list are savedwhen the program is closed regularly.
Any changes made will not be saved if the program crashes or is exited by any means
other than the “Quit” option under the “File” menu or the close button located at the
upper right of the program.

Figure 5.7: The list of test profiles on the main screen.
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Configuring, Running and Saving a Test

The Sequence View
The Sequence View is the area on the main screen where the test information is created and
stored. The column order seen in the Sequence View can be altered depending on preference
(see Configuring Test Settings). The Reading column contains the measurements taken from
the instrument. The Sequence View is saved with the current Test Profile and will be loaded
alongside the Test Profile.

Adding/Removing a Test
There are two methods by which to add a test to the sequence, with the Insert button or by
editing the last row (see Fig. 6.1). Selecting the row number of a test (highlighting it) and
pressing the Delete key will remove the test from the list.

Figure 6.1: Two methods of adding the same test to the sequence, with the Insert
button or by editing the last row.

Adding Tests via Insert Button:
By selecting the test parameters in the menus above and pressing the Insert button, the
parameters are added to the sequence all at once. The Insert button will be enabled only
when a full set of test parameters has been selected.

Adding Tests by Editing the Last Row:
Alternatively test parameters can be selected by clicking in each parameter field of the last
row of the sequence. This will add the parameters one by one, and a full set of test parame-
ters must be chosen before running the test.
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Adding Multiple Tests at Once
• The Test Parameters method allows you to insert multiple tests into the sequence at once
by entering multiple values, separated by commas, into the parameter input boxes (see
Fig. 6.2).

• To enter in a range of values, such as for channel or detector parameters, use a ”-” symbol
in between the start and end of a range of values.

Figure 6.2: 12 tests were created using the parameter list method. Note that all test
types selected are added for each selected wavelength in sequential order.

Adding Tests to the Middle of the Sequence
You may insert tests into the middle of the sequence by using the Insert button (Fig. 6.3 and
Fig. 6.4).

• To insert a test into the middle of the sequence, you must select the row of the list where
the new test is to be inserted.

• You may select the test in the sequence by clicking on row header (containing the row
number).

• Clicking on the “Insert” button will cause the new test to be inserted into the sequence
before the selected test.

• Multiple tests can be selected by either dragging the cursor and highlighting a number
of rows or by holding the Ctrl key and selecting rows one by one.

• When multiple tests are selected from the sequence, the new test will be inserted into
the list before each selected test.
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Figure 6.3: (Left) Before a test at 1625 for PWR was added. (Right) After the test was added.

Figure 6.4: (Left) Before tests at 1550 for BR were added. (Right) After the tests were added.
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Figure 6.5: A sample sequence with pause messages enabled.

Adding Pauses
• Pauses can be added to a series of tests. Simply check the box under the Pause column
where a pause is desired (see Fig. 6.5).

• Pause messages and descriptions can be entered into the respective text boxes to pro-
vide additional information.

• A dialog will appear when a pause is reached containing a live reading of the current
test type and the pause message.

Running and Saving a Test
Once all the configuration is done it is recommended to save the current test profile.

• If a reference has not been taken, ensure the Acquisition value is set to Reference and
not Measurement.

• Pressing the Start button in the top left corner of the main screen will run through all
the tests once to reference the instrument. For extended instructions on referencing see
Taking a Reference.

• Press the Start button in the top left of the main screen to begin the testing. Use the
Pause and Stop buttons during the testing to pause and stop the test if needed.

• Switch to the Results tab to see the results organized in rows. Use the drop-down menu
above to switch between the results for each instrument (see Fig. 6.6).

• Use the Save Results button to save an Excel file if the test was not configured to do so
automatically.

Figure 6.6: A sample set of test results organized by instrument.
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Graphing Data
If performing a long-term test the data measurements can be graphed in real time and ana-
lyzed after the test has finished.

Plotting the Data
Creating and Viewing a Plot:

• Begin by setting up a long-term test (see Configuring Test Settings) and running it. While
the test is running press the View Graph button on the main screen.

• If a test is not running a window (Fig. 6.7) should appear. There will be tabs at the
top to switch between Insertion Loss, Backreflection, Power, IL Average and Polarization
Dependent Loss.

• The y-axis is in units of either dB or dBm depending on the quantity being measured,
and the x-axis is expressed as both a date and time.

• If a test is running the corresponding graph tabs will update automatically as data is
collected.

• Hold Shift and scroll with the mouse to zoom in and out.

• Hold Ctrl and drag the mouse to move the area of focus.

Figure 6.7: The graph screen when no test has been initiated.
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Figure 6.8: A sample plot of power vs time for three wavelengths (Green: 1310, Blue: 1490, Red: 1550).

Filtering Plots:
• Underneath the graph space are two tabs labeled Plots and Markers. On the Plots tab
are options for selecting which plots are visible based on values such as wavelength,
channel, etc.

• Use the check-boxes to select plots one by one or via the drop-down lists.

Utilizing Markers
Adding and Moving Markers:

• Data markers can be used to identify specific values on the completed graphs.
• Data markers can be added whilst a test is running but it is recommend to wait until a
test has concluded before doing so.

• Select the Markers tab in the graphing window to view the marker options (Fig. 6.9).
• Two markers are available for every wavelength value and can be enabled individually
by using the Enabled check-boxes under Cursor 1 and Cursor 2.

• The markers will appear on the bottom left corner of the graph area, and can be moved
by clicking and dragging either the horizontal bar (vertical movement only), the vertical
bar (horizontal movement only) or the center reticle (any movement allowed).

• The right half of each cursor’s field are two boxes listing the X and Y positions of the
marker’s center reticle. Entering a specific value into these boxes will move the reticle
to the specified value.
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Figure 6.9: A sample Backreflection graph with two data markers enabled.

Additional Marker Options:
• The colour of each marker can be customized by entering the colour menu accessed via
the square next to the Colour label.

• Enabling the Snap to Data Points check-box will restrict the movement of the reticle to
the data points taken by the instrument as opposed to being able to move freely.

• Use the drop-down list at the bottom of the tab to switch between markers for separate
wavelengths.
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Taking a Reference

The GMS allows you to take IL references and BR references through the software. To do so,
click the Settings menu then select Take Reference. The window in Fig. 7.1 should appear.

Figure 7.1: The main reference window.

• Begin by selecting the instrument you wish to reference from the drop-down list.

• In the textboxes, enter the channels, wavelengths and detectors you would like to take
the reference for.

• If you have all the channels connected to the detector already, select the second radio
button: “Take reference for all channels at once”. The software will automatically run
through the specified channels and take the reference.

• If you would like to connect and take the reference one channel at a time, select the first
radio button: “Take reference one channel at a time”. The software will prompt you one
channel at time through the channels.
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Referencing One Channel at a Time
For this example and section 7.2, this manual will only look at IL referencing. The software
will function identically for taking a BR reference. Example in Fig. 7.2.

Figure 7.2: Referencing one channel at a time for an MBR5.

Upon clicking the “IL Reference” button, the window in Fig. 7.3 should pop up:

Figure 7.3: The window prompt for the first channel reference.

• The label shows the information about the reference. The software will prompt you
through all the channels (in this case, all 1-12) and wavelengths (1310 and 1490).

• The Reading label shows a real time reading that the meter is receiving (if taking IL
Reference, the meter will be in Relative Power Mode. If taking BR Reference, the meter
will be in Backreflection Mode).

• To take the reference for the specified channel, click Take Reference. The software will
proceed to switch to the next channel/wavelength and you can now connect the next
channel to the detector, by selecting Take Reference.

• Repeat until all channels have been referenced. To stop taking the reference, click Stop.
The previous channels referenced will remain referenced.
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Figure 7.4: Referencing all channels at once for an MBR5.

Referencing All Channels at Once
• If all the channels being referenced are already connected to the detector, then you may
choose to have the software take the reference for all channels automatically without
having to specify one channel at a time.

• Upon clicking the IL Reference button with Take Reference for all Channels at Once se-
lected, the window in Fig. 7.5 should pop up.

Figure 7.5: The auto-updating window for referencing all channels.

• This window merely shows the process of the software taking the reference. To stop
taking the reference, click the “Stop” button (the channels already referenced will still be
referenced).
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